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1. Introduction to SplashID Enterprise 

SplashID Enterprise is designed to quickly and effectively address the most immediate 
password management concerns of IT.  It allows an organization to use stronger password 
management practices without compromising security or increasing costs. 
 
SplashID Enterprise provides a complete password management and security solution for 
organizations using either Windows or Mac OS platforms for end users. SplashID Enterprise 
offers IT managers powerful control for the centralized administration of password and 
security policies across various departments and employee groups throughout an 
enterprise. 
 
Benefits of SplashID Enterprise 
 

• Increase employee productivity: SplashID makes managing and accessing passwords 
easier and more convenient, giving your employees more time to focus on important 
tasks. SplashID will decrease forgotten password requests, ridding IT of unnecessary 
distractions and allowing focus on projects that create real value. In addition, the 
next update of SplashID Enterprise will optionally give your employees access to 
records on their smartphones, enabling them to be more productive out of the office 
as well 

• Decrease potential costs of security threats. As described earlier, the costs of data 
breaches are astronomical. By implementing SplashID, your organization 
significantly reduces the risk of information stolen via password exposure, including 
data loss, legal costs, the loss of customers, and the loss of employee productivity 

 
 
The major features of SplashID Enterprise include: 
 

• Cross-platform Windows and Mac end-user support 
• Support of MySQL server on Windows, Mac, or Linux 
• Centralized secure database of usernames, passwords, documents, and other 

records 
• Administrative control panel for IT with user management 
• Customizable group-level and user-level permissions 
• Customizable deployment architecture  
• Multi-layer database securit 

 

1.1. System Overview 

SplashID Enterprise offers a simple architecture that works with existing enterprise systems 
so that SplashID can be up and running on your employees’ computers in very little time, 
under an hour in most cases. 
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There are three components that comprise the SplashID Enterprise System: 
 

• Web Server running MySQL (SplashID database) - SplashID Enterprise records 
are encrypted and stored in a MySQL database server. MySQL server can run on 
Windows, Linux or Mac 
 

• SplashID Enterprise Admin application (used by the IT Administrator) – The 
SplashID Administrative Control Panel application requires root access to the MySQL 
server. The Administrative Control Panel is used for User Management to create, 
edit, delete users and assign permissions on the system. The Admin application can 
run on Windows or Mac 
 

• SplashID Enterprise Client application (used by Employee) - Employees or IT 
installs the SplashID Enterprise client application on desktop instances (Windows or 
Mac). The IT administrator provides employees with initial SplashID Enterprise login 
credentials via an automated system 
 

1.2. System Requirements 

Server OS Windows, Linux, Mac 
Web Server IIS, Apache or any other Web Server 
Database MySQL (run on Windows, Linux or Mac) 
Webservices PHP 
SplashID Enterprise Admin Application Windows, Mac  
SplashID Enterprise Client Application Windows, Mac, Browser, iPhone, Android, BB 
  

1.3. System Deployment 

SplashID Enterprise can be deployed based on the requirements. It can be self-hosted, 
where it is hosted by the company, or it can be hosted on SplashData servers as a service 
in the clould. In the self-hosted deployment option, it can be hosted internally in the 
company’s intranet, or hosted in the cloud (again depends on the requirements). Lets take a 
closer look at the three deployment options: 

1.3.1. Self-Hosted by company (in-house) 

If someone in your organization has experience setting up Web server running MySQL, you 
can easily host SplashID Enterprise in-house (inside your intranet). The setup will generally 
take less than one hour. 
 
Steps to deploy SplashID Enterprise are simple: 

1. Install Web server running MySQL inside company’s intranet 
2. Launch SplashID Enterprise Admin application 
3. Connect Admin application to MySQL server with root access 
4. Create users, assign permissions, and create groups as needed 
5. Employees launch SplashID Enterprise client applications with login details provided 

by Admin 
 
MySQL server needs to be installed on a system inside the company intranet. Admin and 
Clients can access the server only while inside the company network or through VPN. 
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1.3.2. Self-Hosted by company (in the cloud) 

If someone in your organization has experience setting up Web server running MySQL, you 
can easily host SplashID Enterprise in the cloud. The setup will generally take less than one 
hour. 
 
Steps to deploy SplashID Enterprise in the cloud are simple: 
1. Install Web server in the cloud running MySQL 
2. Launch SplashID Enterprise Admin application 
3. Connect Admin application to MySQL server with root access 
4. Create users, assign permissions, and create groups as needed 
5. Employees launch SplashID Enterprise client applications with login details provided 
by Admin 
 
MySQL server needs to have a globally accessible hostname or IP address, which can be 
used by the Admin and Client applications to establish connection. 
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1.3.3. SplashData-Hosted 

SplashData also offers a hosted version of SplashID Enterprise as a service. A hosted 
solution delivers the benefits of fast and easy implementation, high security, and worry free 
management. Hosting services comes at no cost, if you purchase more than 25 licenses. If 
you are interested in a hosted solution, please visit splashdata.com/enterprise or contact 
SplashData by email: enterprise@splashdata.com 
 
 
 

2. Installation Procedures 

Download SplashID-Enterprise.zip installation package from: 
http://www.splashdata.com/enterprise/downloads/ 
   
If you decide to go with Deployment Option-3 (SplashData hosted version of SplashID 
Enterprise as a service), then you can proceed directly to 2.4. SplashData will install MySQL, 
PHP, Webservices and provide you with the login information. 
 
If you would like to host it youself inside your company’s intranet or in the clould, you would 
need to decide on using Windows Server, Mac Server or Linux Server for SplashID 
Enterprise deployment. 
 
Based on your decision, you would need to Enable the Web Server. Depending on your 
server configuration, you could use IIS, Apache, or any other web server. 
 
Verify is the web server is running by performing a ‘http://localhost’ 
 
 

2.1. Install MySQL on Web Server 

MySQL server needs to be installed only if you have chosen- 
Deployment Option 1: Self Hosted inside Intranet (1.3.1) 
or  
Deployment Option 2: Self Hosted in the cloud (1.3.2) 
 
Skip this step if you have chosen- 
Deployment Option 3: SplashData Hosted Solution (1.3.2) 
SplashData will install MySQL and provide you with the login information 
 
MySQL Server can be install on Windows, Mac or Linux.  
Most Linux distributions comes with MySQL bundled. 
Windows installer is included in SplashID-Enterprise.zip 
 
This user-guide has step by step instructions on installing MySQL on Windows Server 2008 
 
1) Under MySQL folder inside SplashID-Enterprise.zip, you will find 2 installers: 
mysql-5.5.15-win32.msi (for 32-bit OS) 
mysql-5.5.15-winx64.msi (for 64 bit OS) 
 
Select and run the appropriate installer based on your server configuration 
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2) Select ‘Complete’ as Setup Type 

 
 
3) Once installation is complete, Launch the MySQL Instance Configuation Wizard  
 

 
 
 

 



SplashID Enterprise Administrator User Guide Version 2.0 

SplashData, Inc 

8 

 

 
4) Select ‘Detailed Configuration’, as it allows you to optimize the server performance to run  
SplashID Enterprise -> Select ‘Server Machine’ -> Select ‘Multi-functional database’ -> DSS 
/ OLAP or OLTP (Depending on your requirement) 
 

 
 
 

 
 
 

 
 
 
5) Enable TCP/IP Networking, and specify the Port Number  (3306 is standard MySQL port). 
If you specify a different port, it needs to be changed in SplashID Enterprise (both Admin 
and Client app). All firewxcepton o this port, and Enabe Strict Mode 
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6) Select Standard Character Set. Install MySQL as a indows Service and select ‘Launch the 
MySQL server automatically’. Inclue Bin directory in Windows PATH 
 
 

 
 

 
 
 
7) Setting MySQL root password is the most important step in installation of MySQL and 
setup of SplashID Enterprise 
 
Administrator needs to log into SplashID Enterprise Admin app as ‘root’ or ‘root-like’ user. 
 
After settings root password, Enable ‘root access from remote machines’ if you need to use 
SplashID Enterprise Admin from another system 
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8) Execute the configuration settings 
 

 
 

 
 
Note regarding Linux/Mac Web Servers installations: 
Linux/Mac Web server deployment might require some MySQL configuration: 
 
1)There is a default MySQL table called information_schema. 
Check the value of Global Variable - 
LOWER_CASE_TABLE_NAMES VARIABLE_NAME="LOWER_CASE_TABLE_NAMES"; 
It should be VARIABLE_VALUE=1 
 
If it is 0, then you need to edit it in the my.cnf file. 
And set it to 1 in the my.cnf file, restart MySQL and make sure that the 
Global variable is now set to 1. 
 
2) Make sure root user can be accessed from other systems- 
GRANT ALL PRIVILEGES ON *.* TO 'root'@'%' IDENTIFIED by '<password>' WITH 
GRANT OPTION; 
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If you still see issues, try installing MySQL 5.1.47- 
 
You can download 5.1.47 from here: 
http://downloads.mysql.com/archives.php?p=mysql-5.1&v=5.1.47 
 
 

2.2. Install PHP 

PHP needs to be installed only if you have chosen- 
Deployment Option 1: Self Hosted inside Intranet (1.3.1) 
or  
Deployment Option 2: Self Hosted in the cloud (1.3.2) 
 
Skip this step if you have chosen- 
Deployment Option 3: SplashData Hoste Solution (1.3.2) 
SplashData will install PHP and provide you with the login information 
 
PHP can be installed on Windows, Mac or Linux servee 
Windows installer is included in SplashID-Enterprise.zip 
 
Once PHP installation is complete, to verify that the PHP is running and operating correctly, 
create the following script placing the same on the web folder. 
 
<?php 
 
phpinfo(); 
 
?> 
 
Then point the browser to the URL associated with the script.Example. copy paste the script 
to a notepad and save the file as test.php. Then put the file in to the web folder and browse 
the same as http://<your IP or hostname>/test.php. 
 
It will give you the entire details of your PHP installation along with associated modules 
installled 
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SplashID Enterprise requires the PHP m_crypt library, which might require additional 
installation.  
 
Check if mcrypt library is enabled in the phpinfo() test.php verficiation page. 
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If it is not enabled, download and enable it. Details here: 
http://php.net/manual/en/book.mcrypt.php 
 

2.3. Install SplashID Enterprise Web Services 

 
In SplashID-Enterprise.zip, there is a folder called ‘Webservices’ 
It contains the folder ‘splashid’ along with four subfolders – bbmobileclient, mobileclient, 
webclient, webservices 
 
Copy the ‘splashid’ folder and place it in the root path of your web folder 
 
In the example below (Windows server running IIS), wwwroot contains ‘splashid’ folder as 
shown below 
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Test if the login screen can be accessed by entering the URL in the browser: 
http://<server IP or hostname>/splashid/webclient/login.php 
Ex: http://localhost/splashid/webclient/login.php 
 
Alternatively, you can deploy it securely over HTTPS as well. 
 
 

 

2.4. Install SplashID Enterprise Admin 

SplashID Enterprise Admin Windows and Mac application are included in SplashID-
Enterprise.zip inside the ‘Admin’ folder 
 
SplashID Enterprise Admin application: 

1) Connects to the Web Server running MYSQL 
2) Creates SplashID Enterprise database 
3) Creates Groups, Types, Users 
4) Creates Users, Assign permissions 
5) Contains the Event Viewer for logging 
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2.4.1. Windows 

1) Run the SplashID-Enterprise-Admin.exe for Windows 
2) Launch SplashID Enterprise Admin application  
Windows - (Start Menu -> Programs -> SplashData -> SplashID Enterprise -> SplashID 
Enterprise Admin 
3) Enter login details of Web server running MySQL 

 

 
 
Server IP Address - is the address of the system on which Web server is running MySQL 
Alternatively, hostname of the server could also be entered. 
Port – Port on which MySQL is running on the system. Default port is 3306.  
MySQL Username – <root username> 
MySQL password - <root password> 
SplashID Master Password:: Keep it Blank on first launch, as it needs to be set 
 
Note: SplashID Enterprise Admin can log on as a root or a root like user (that has ability to 
create other MySQL users on the system) 
 
Set Master Password. Once the database is created, this password is used to encrypt the 
SplashID Enterprise database. End-users (Clients) on the system would need SplashID 
Enterprise Master Password to access their account 

2.4.2. Mac 

1) Run the SplashID-Enterprise-Admin.dmg for Mac 
2) Launch SplashID Enterprise Admin app from Applications folder 
3) Enter login details of Web server running MySQL 
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Server IP Address - is the address of the system on which Web server is running MySQL 
Alternatively, hostname of the server could also be entered. 
Port – Port on which MySQL is running on the system. Default port is 3306.  
MySQL Username – <root username> 
MySQL password - <root password> 
SplashID Master Password:: Keep it Blank on first launch, as it needs to be set 
 
Note: SplashID Enterprise Admin can log on as a root or a root like user (that has ability to 
create other MySQL users on the system) 
 
Set Master Password. Once the database is created, this password is used to encrypt the 
SplashID Enterprise database. End-users (Clients) on the system would need SplashID 
Enterprise Master Password to access their account 
 

2.5. Install SplashID Enterprise Client 

SplashID Enterprise Client applications are to be used by end users, whose accounts have 
been created in the SplashID Enterprise system. SplashID Enterprise Client applications 
must be provided to the end-users. 
 
SplashID-Enterprise.zip contains the following Client applications (to be used in the 
respective folders: 
 
Client -> Contains Windows and Mac SplashID Enterprise Client application 
Mobile-Clients -> Contains Android SplashID Enterprise Client 
Note: iPhone and BlackBerry clients will be available shortly 
 

2.5.1. Windows 

 
1) Run the SplashID-Enterprise-Client.exe installer for Windows 
2) Launch SplashID Enterprise Client application  
Windows - (Start Menu -> Programs -> SplashData -> SplashID Enterprise -> SplashID 
Enterprise 
3) Enter user login details  
 
 

 
 
Server IP Address - is the address of the system on which Web server is running MySQL 
Alternatively, hostname of the server could also be entered. 
Port – Port on which MySQL is running on the system. Default port is 3306.  
SplashID  Username – <client username> 
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SplashID User password - <temp client user password creatd by admin> 
SplashID Master Pasword - <Master Password set by Admin> 
 
Note: Admin should encourage the end user to change the temp user password after first 
login. 
 
Once SplashID Enterprise Client application is launched by the end user, they would see the 
Groups and records they have access. SplashID Enterprise Client user guide is available in 
the SplashID-Enterprise.zip, comes with installation and available on SplashID Enterprise 
website. 
 

2.5.2. Mac 

1) Run the SplashID-Enterprise-Client.dmg installer for Mac 
2) Launch SplashID Enterprise Client application from Applications folder 
3) Enter user login details 
 
 

 
 
Server IP Address - is the address of the system on which Web server is running MySQL 
Alternatively, hostname of the server could also be entered. 
Port – Port on which MySQL is running on the system. Default port is 3306.  
SplashID  Username – <client username> 
SplashID User password - <temp client user password creatd by admin> 
SplashID Master Pasword - <Master Password set by Admin> 
 
Note: Admin should encourage the end user to change the temp user password after first 
login. 
 
Once SplashID Enterprise Client application is launched by the end user, they would see the 
Groups and records they have access. SplashID Enterprise Client user guide is available in 
the SplashID-Enterprise.zip, comes with installation and available on SplashID Enterprise 
website. 
 

2.5.3. Browser (Web Client) 

SplashID Enterprise Web Client can be access on any browser (desktop, tablet, mobile 
device, etc) 
 
SplashID Enterprise web client login can be accessed by: 
http://<server IP or hostname>/splashid/webclient/login.php 
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Ex:  
http://localhost/splashid/webclient/login.php 
http://46.131.44.32/splashid/webclient/login.php 
http://splashid.companyx.com/splashid/webclient/login.php 
 

 
 
SplashID  Username – <client username> 
SplashID User password - <temp client user password creatd by admin> 
SplashID Master Pasword - <Master Password set by Admin> 
 
Note: Admin should encourage the end user to change the temp user password after first 
login. 
 
Once SplashID Enterprise Client application is launched by the end user, they would see the 
Groups and records they have access. 
 

2.5.4. Mobile Device (iPhone, Android, BlackBerry) 

Moblie-Clients folder is included in SplashID-Enterprise.zip 
Installation read-me.txt is included in each folder. 
 
SplashID Enterprise can be installed on Android device by one of the following options: 
1) Point your Android browser to - http://splashdata.com/sidenandroid 
2) From Android Market - You can Search the Android Market for 'SplashID Enterprise' and 
download it directly on the device 
 
SplashID Enterprise can be installed on BlackBerry device by one of the following options: 
1) Point your BlackBerry browser to - http://splashdata.com/sidenbb 
2) Using BlackBerry Desktop manager, import the SplashIDEnterprise.alx file 
3) From BlackBerry App World (pending approval) 
You can Search the App World for 'SplashID Enterprise' and download it directly on the 
device 
 
SplashID Enterprise iPhone - iOS applications cannot be installed directly on iPhone, iPad or 
iPod touch. They canbe installed only from iTunes App Store 
1) From iTunes App Store - You can Search the App Store for 'SplashID Enterprise' and 
download it directly on the iPhone, iPod touch, iPad 
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SplashID Enterprise Mobile device login screen: 
 

 
 
Select ‘http’ or ‘https’ depending on the deployment 
URL - is the address of the system on which Web server (enter hostname or IP address) 
SplashID  Username – <client username> 
SplashID User password - <temp client user password creatd by admin> 
SplashID Master Pasword - <Master Password set by Admin> 
 
Note: Admin should encourage the end user to change the temp user password after first 
login. 
 
Once SplashID Enterprise Client application is launched by the end user on mobile device, 
they would see the Groups and records they have access. SplashID Enterprise Client user 
guide is available in the SplashID-Enterprise.zip, comes with installation and available on 
SplashID Enterprise website. 
 
 
Browsers on Smartphones and Tablets can access SplashID Enterprise web client by: 
http://<server IP or Hostname>/splashid/webclient/login.php 
 
Ex:  
http://localhost/splashid/webclient/login.php 
http://46.131.44.32/splashid/webclient/login.php 
http://splashid.companyx.com/splashid/webclient/login.php 
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3. User Management 

The User Management module contains allows the Admin to: 
 

• Set Password Policy 
• View list of users on the system 
• Create Users / Assign permissions 
• Import / Export Users 

 
 

 
 

3.1. Set Password Policy 

Company-wide Password policy can be set by the Admin, so that every user’s SplashID  
password meets the minimum password requirements. 
 
In the below example, Password Policy set is – 6 character alpha-numeric 
It means, the minimum strength of the user password must be 6 character alpha-numeric 
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3.2. Create Users 

New users can be created by selecting ‘New’ in the User Management module. 
 

 
 

 
 
Here you can Create New Users or Edit details of existing users. 
Select the Groups user has access to by selecting drop down ‘Add more Groups’- 
 
Note: If you would like to send the details directly (not using the SplashID Enterprise 
system) de-select the ‘Send details to user via email’ option 
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3.3. Assign Permissions 

You can assign Group Level, Type Level, Records Level and Data Level Permissions to the 
users under the ‘User Permissions’ tab. 
 
If you ‘Select All’ you can essentially creating a Super User 

 
 

3.4. Import / Export Users 

Users can be imported from a csv file. 
 
Format of the csv is as follows- 
Username, Password, Confirm Password, Full Name, Description, Email, Phone, Group-
Permission, Type-Permission, Record-Permission, Data-Permission 
 
Exmaple- 

 
 
Permissions fields- 
Group-Permission, Type-Permission, Record-Permission, Data-Permission 
1 – User has permission 
0 – User does not have permission 
 
Similarly, for backup purposes, users can be export to a csv with the same format as Import 
 
Note – If you use Active Directory to maintain users on the system, you can export to CSV, 
modify the CSV to be imported into SplashID Enterprise 
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3.5. Backup 

Users: You can backup the SplashID Enterprise users on the system by perform a ‘Backup’ 
in the User Management module 
 
Records:  
SplashID Entrprise database can be backup by File -> Export -> vID (Backup All Records) 
Alternatively, MySQL database can also be backed up, which contains SplashID Enterprise 
records. 
 
To Import the vID, File -> Import -> vID. 
Similarly, MySQL backup can also be resoted 
 
You can share information with other SplashID Desktop users by exporting and importing 
your SplashID records. Records can be exported/imported on the desktop in several 
formats: 
 
SplashID vID - You may import and export SplashID records in SplashID Virtual ID (vID) 
format, which allows you to export and import records in a secure, encrypted format. vID 
files may be encrypted by assigning a password when exporting. The recipient of the vID file 
may import the data into their copy of SplashID Enterprise by double-clicking the file, or 
choosing Import/SplashID vID from the File Menu. If a password was assigned to the file, 
the recipient must enter the password in order to import the data. 
 
CSV – Records can also be imported and exported as CSV, but vID is a more secure way of 
doing it. 
 

3.6. Event Viewer 

View -> Event Viewer shows all the activity on the system 
 
This is available only inside SplashID Enterprise Admin app 
 

 
 
Along with the in-built event viewer, advanced MySQL tracking and logging can be setup to 
track users on the system. 
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4. SplashID Enterprise Admin Application - Operation 

SplashID Enterprise Admin application is a fully functional version of SplashID, that can 
perform Groups, Types and Record level activity along with Import. 

4.1. Groups 

Groups can be created for Departments or Groups within the company.  
The idea is that Every Groups has a set of records inside it. A user assigned to Group X can 
view records in Group X. Groups act as filters for grouping related records.  
Groups can be created / edited from File -> Edit Groups 
 

 
 
 
Editing a Group, allows assigning Users to the Groups- 
 

 
 
Groups can be created on the Admin application or Client application (provided the end user 
has the permission to create or edit  Groups) 
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4.2. Types 

Types act as templates, which define the structure for the items you want to store in 
SplashID. You may define up to 9 custom field labels and a default icon for each type, as 
well as specify the fields you wish to mask. For example, you may create a type for Web 
Logins, which includes custom field labels for username, password and URL, with a globe 
icon, and the password field masked; and you may create a Type for Credit Cards which 
includes custom field labels for credit card number, expiration date and PIN, with a Visa 
icon, and the credit card number and PIN masked. 
 

• Edit Types - Select Edit Types from the type menu to display the Edit Types dialog. 
You may create an unlimited number of Types. Several sample Types are provided, 
which you may edit or delete. Select an existing type and click edit, or click New to 
create a new one. The Define type dialog is displayed. 

• Define Type - Enter a name for the Type and up to 9 custom field labels. The Mask 
checkbox specifies whether or not the data in that field will be masked. And you may 
also specify a default icon for the Type. 

 

 

4.3. Records 

Each record has the below fields. They can be edited from the Edit Record screen- 
 

• Group – Record Group 
• Type – Record Type 
• Fields - Enter your data according to the field labels.  
• Custom Field Labels - You may assign Custom Field Labels by clicking the Custom 

button. 
• Masking - A bullet appears to the right of any field that is masked. You may 

customize the field masking by clicking the bullet or selecting Customize Field Labels 
from the Options Menu. 

• Buttons -  
o Icon: opens the icon selector. New in version 5, you can add a custom icon 

to any record. 
o Attach File: Attach any file to the record for future reference. Attached files 

are saved in a folder next to the database. 
o Password opens the Automatic Password Generator (below). 
o Duplicate creates a copy of the record. 
o Custom opens the Custom Field Label dialog. 
o Delete deletes the current record, after confirming that is what you wish to 

do. 
o OK exits the record, saving any changes.  
o Cancel exits the record, discarding any changes. 
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5. Licensing 

SplashID Enterprise is sold as a complete software service, including the Administration 
panel, desktop applications, web clients, mobile clients, installation assistance, lifetime 
service and support (via email and telephone), and optional remote hosting (at no additional 
charge for over 25 users). 
 
SplashID Enterprise seats are billed on a monthly basis and based on client access license 
per-user i.e, one license per end-user. That one user could use it on multiple platforms 
and/or devices 
 
If you have any questions about licensing or need custom licensing , please contact Arjun 
Thyagarajan at 408-335-7363 or email - enterprise@splashdata.com 
 
Licenses can be purchased from (pricing information included): 
http://www.splashdata.com/enterprise/purchase.htm 
 

6. Support and Maintenance 

SplashID Enterprise is sold as a complete software service, including the Administration 
panel, desktop applications, web clients, mobile clients, installation assistance, lifetime 
service and support (via email and telephone), and optional remote hosting (at no additional 
charge for over 25 users). 

6.1. Support Ticket 

You can raise a SplashID Enterprise ticket here: 
http://splashdata.helpserve.com/ 
 
More details here: 
http://www.splashdata.com/enterprise/support.htm 
 

6.2. Advanced Phone Support 

Advanced phone support is provided at: 408-335-7363 
 
More details here: 
http://www.splashdata.com/enterprise/support.htm 
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6.3. Maintenance 

SplashID Enterprise is sold as a complete software service comes with lifetime maintenance, 
service and support (via email and telephone) 
 

6.4. Troubleshooting 

Linux and Mac server installations might require trobleshooting on certain occasions. Refer 
notes under MySQL and PHP installation procedures. 

6.5. Frequently Asked questions 

How do I get support? 
http://www.splashdata.com/enterprise/support.htm 
 
How secure is SplashID Enterprise? 
SplashID Enterprise allows you to securely store company data. Data is encrypted, 
protected, and locked on a central database, and only users that have access to the system 
can read or edit data. 
 
Key Security Features of SplashID Enterprise 
 

• 256-bit Blowfish and AES encryption - Your SplashID data goes through two 
rounds of encryption - 256-bit AES and 256-bit Blowfish. The password is also 
encrypted within the MySQL database. SplashID Enterprise uses approved Blowfish 
and AES libraries for all of its encryption and key generation. SplashID Enterprise is 
also compliant with FIPS 140-1 and FIPS 140-2. 

 
• Secure communication - Client-server communication of SplashID data occurs 

only when the data is in an encrypted state. Communication is directly over TCP/IP, 
where IPsec provides an additional layer of security. 

 
• Secure MySQL database - MySQL itself encrypts the data using the in-built MySQL 

encryption methods. Only the SplashID Enterprise Admin with root access can log in 
to the database. If the database is running locally or within the company network, 
TCP networking can be disabled for remote access. 

 
• User Permissions - While creating users, the SplashID Enterprise Admin applies 

access control settings for each user. The Admin assigns Group and record based 
permissions, and so each employee's access depends on the permissions granted by 
the Admin. 

 
• Secure Backups - SplashID Enterprise Admin can backup the company's SplashID 

data to a secure password protected SplashID vID file. Also, the entire MySQL 
database can be backed up, and that backup is also encrypted. 

 
• Timeout - SplashID will automatically lock and hide the data after a specified period 

of time, so the Admin or employee doesn't need to remember to logout of SplashID 
when leaving a desk. 

 
• Strong Password Generator - Admin and users can use the customizable 

Password Generator in SplashID to create passwords that are complex and 
unguessable. 
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Can SplashID Enterprise be used to store attachments securely? 
Yes, attachments in records are encrypted and stored securely in the SplashID Enterprise 
database. 
 
How much do SplashID Enterprise licenses cost? 
http://www.splashdata.com/enterprise/pricing.htm 
 
 
 
 
 

  


